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Introduction

CTR2-Flex is the descendant of a long line of microcontroller-based radio controllers from Lynovation. If
you’re interested in its background, you can read the QEX and QST articles about the CTR series here.

CTR2-Flex hardware uses the same M5Dial touchscreen controller as CTR2-Dial hardware and can run
CTR2-Flex or CTR2-Dial firmware. CTR2-Flex hardware has the following modifications:

e The simple encoder/paddle jack interfaces on CTR2-Dial were replaced with a custom PCB that
uses a 12C port expander IC to add additional I/O capabilities to the ESP32-S3 processor

e The encoders were replaced with units that have push switches

e Support for the CW paddle jack was added for dual-encoder hardware

o A speaker driver, volume control, and speaker were added for greater sidetone volume

Both CTR2-Flex and CTR2-Dial firmware are included in the release of CTR2-Flex v2.00.00 firmware. You
can easily switch between the two firmwares in the Settings menu to fit your operating needs. You
should refer to the CTR2-Dial Operation Manual for information about running CTR2-Dial firmware.

CTR2-Flex firmware creates a custom WiFi controller specifically
designed for the Flex 6000 and 8000 SDR radios. It is based on the
popular CTR2-Micro and CTR2-Dial controllers’ and firmware. It
utilizes the Flex Network APl to monitor and control the Flex radio
over an IP network connection. In addition, it provides real-time
CW keying and PTT control over the network.

Because the Flex API is a two-way protocol, unlike CTR2-Dial,

CTR2-Flex is aware of the radio’s operating state (frequency,
mode, band, etc.) A Dashboard display provides easy access to many of the radio’s functions.

CTR2-Flex Operation Manual v2.02 Page 3


https://ctr2.lynovation.com/
https://ctr2.lynovation.com/article-reprints/
https://ctr2.lynovation.com/ctr2-dial-operation-manual/

NOTE: If this firmware is installed on dual-encoder CTR2-Dial hardware you must select either # Knobs:
Two or # Knobs: Swap A/B in the Settings menu, otherwise the encoder on Port B will continually key

the internal keyer.

How to use this manual

This manual should be used as a reference manual. An expanded Help system if you will. Items in the
Table of Contents link to their write up in the manual. I've tried to group things logically and have added
hyperlinks so you can quickly jump to other sections.

As this document evolves, sections that have changed since the last update will be highlighted in yellow.
The version number of this manual will follow the latest released version number of the firmware.

Feel free to contact me if you have question about a certain feature or have ideas for future
improvements. | love to get feedback on my work. My email addrelss is good on QRZ.com.

Legal Notice
What would a manual be without a legal notice? Here goes...

e This is a hobby endeavor. Nothing is guaranteed! Use this device at your own risk!

e | will do my best to make sure you receive functioning hardware if you buy the assembled unit
and will work with you if there is a problem with your unit on arrival.

e | cannot guarantee or warranty the hardware supplied in kits.

e | make no warranty that the firmware provided will perform up to your expectations or be

suitable for your application. A lot of compromises had to be made to fit the small display so

review this manual to be sure you’re comfortable with the user interface.

e Software bugs are a fact of life and | try to find and correct all bug reports to the best of my
ability ASAP.

o CTR2-Flex requires a license key to be fully functional. License keys can be purchased separately
if you build your own unit. They are included with any purchase of a CTR2-Dial or CTR2-Flex
product from Lynovation.com.

e License keys are tied to your call sign. This allows you to use the same key on as many devices as
you own. You are not allowed to include you license key on units you build to sell or give to
others. They will need to purchase their own key.
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Change Log

v2.03.03: September 16, 2025
e Added Touch Delay On/Off to Setting menu to enable or disable the 120-millisecond delay on
touch events that was added in v2.03.02
e Display selected Rx antenna on the dashboard home page

v2.03.02: September 10, 2025
e Added 120 mSec debounce to screen touch — Some M5Dials send random touch events
e NOTE: v2.02.01 was released for one day but had bugs in the debounce code

v2.03.00: September 4, 2025
e Fixed major bug causing radio to reset when disconnecting CTR2-Flex from WiFi
e Added option to save favorite frequencies per band or for all bands

e Added Edit Call & Key option to Setting menu — allows you to enter your registration credentials
without a terminal program

v2.02.00: August 18, 2025
o Added Ring Control options — you can now assign a dial function to the gray ring encoder on the
display

e Removed the Mono option on the Dial menu and replaced it with LnO-Gn (Lineout Gain) to set
external speaker drive.

e Documented how to set up you CTR2-Flex to use an external keyer and/or hardware PTT switch
on the Paddle Input jack.

e Added a VFO Lock option

v2.01.01: August 10, 2025
e You can now choose if you want to reset your call and registration key in the Reset to Factory
option.

v2.01.00: August 7, 2025
e Added extended frequency support for transverters. Selecting XVTA or XVTB on the Antenna
page in the dashboard adds 2m, 1.25m, 70cm, 33cm, and 23cm bands to the Band page.
e Fixed a bug that was causing unpredictable control states on radios with multiFlex enabled.
e Removed the Knob A double-click to toggle the radios’ TX mode and now allow the switch on
Knob A (and Knob B on dual-encoder units) to be assigned to execute any Button function.

e Rearranged the Antenna, Band, and Mode pages in the dashboard.
e Added a new link to download Tera Term. Get it from the CTR2 Group IO File folder here.

Changes to previous firmware versions can be found in Appendix F
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System Overview

CTR2-Flex hardware utilizes the M5Dial from M5Stack.
M5Dial is small controller based on the ESP32-S3 processor
and includes a 1.28” round display and an integrated
encoder. It can be powered from a USB connection, an
external 6-to-36-volt battery, or from a 3.7-volt Lithium
battery. The current version of CTR2-Flex unit uses

USB for power. The user can upgrade their unit to use
these other power sources if desired.

CTR2-Flex hardware is similar to CTR2-Dial in that it
provides one or two external encoders and a 3.5mm CW paddle jack. Unlike
CTR2-Dial, the interface PCB in CTR2-Flex allows for two encoders with push switches and the CW
paddle jack. It also provides a speaker with a volume control to provide a useable sidetone for CW
operation. CTR2-Flex firmware can be installed on CTR2-Dial hardware but you don’t get the knob switch
feature and the sidetone on CTR2-Dial isn’t loud enough for regular use.

CTR2-Flex firmware is compatible with Flex 6000 and 8000 model radios. It uses WiFi to connect directly
to the radio over your IP network using the Flex APl and provides a small but flexible control surface for
your radio. Unlike controlling SmartSDR with a mouse, SmartSDR doesn’t need to be “in focus” on your
computer to use CTR2-Flex. In addition, its small size allows you to conveniently locate it anywhere on
your operating desk.

Since it connects directly to the radio it works with any Flex control app including SmartSDR for
Windows and SmartSDR for i0S/MacOS.

CTR2-Flex firmware provides the essential controls you need to operate your radio without any other
control app. This is ideal if you just want to monitor a band or operate your radio in POR mode (i.e. Plain
Old Radio) without booting your computer or iPad to use SmartSDR.

CTR2-Flex hardware includes a built-in keyer with sidetone and can send both key and PTT inputs to the
radio over the IP network. Using Straight Key keyer mode allows you to connect an external keyer, PTT
switch, or app such as NIMM to the CTR2-Flex’s CW paddle jack to key the radio. In addition, the virtual
PTT switch can be configured for momentary or latched PTT.

CTR2-Flex firmware has two user interfaces and you can use the one that works best for you.
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Two Controllers / Two Firmwares
As mentioned previously, two versions of hardware and two versions of firmware are available.

CTR2-Flex firmware is great for controlling your Flex radio locally running any version of SmartSDR (or
even without the SmartSDR user interface). However, since it doesn’t support SmartLink, it presents
challenges for remote operation.

CTR2-Dial firmware, on the other hand, excels at remote operation because it leverages the ability of
Marcus’ (DL8MRE) SmartSDR for iOS/MacOS app to access SmartLink. It can also be used locally.

CTR2-Flex and CTR2-Dial firmware can run on either CTR2-Flex or CTR2-Dial hardware. Starting with
CTR2-Flex v2.00.00 firmware you can switch between the two firmwares without re-flashing your unit.

The diagrams below should give you an idea of how each firmware interfaces to your radio and your
computer/iOS device.

When using CTR2-Flex el
uss e
Power . ... .

firmware as shown here,
the controller connects
to, and directly controls
the radio through the IP
network using WiFi and

the Flex Network API. e, |
CTR2-Flex firmware 7Y i Flex 6000/8000 radio SmartSDR running on
running on connected to both Windows, iOS, or MacOS
CTR2-Flex or CTR2-Dial CTR2-Flex and SmartSDR ”
hardware with Flex Network API PC connected to router
with WiFi or CATS
Bluetooth*
e —o=-- — S

o N CATS to radio
\\fg:s, '

When using CTR2-Dial

firmware, the controller

connects to, and

controls the 3™ party T ee—

" smarSDR running on . Flex 6000/8000 radio

H H CTR2-Dial firmware s ;
app thatis controlllng running on CTR2-Flex or e e Mac or iOS device connected to SmartSDR
. CTR2-Dial hardware
the radio. ** CAT5 or WiFi from
Controlling SmartSDR using MIDI SmartSDR to radio

* Bluetooth or USB MIDI
to SmartSDR

CTR2-Flex Operation Manual v2.02 Page 7


https://ctr2.lynovation.com/ctr2-flex/
https://ctr2.lynovation.com/ctr2-dial/

There are a few of trade-offs when running CTR2-Flex firmware on CTR2-Dial hardware:

e CTR2-Dial hardware doesn’t have encoder switches so you can’t press and turn Knob A to
change the frequency step or assign Knob switches to Button functions.

o CTR2-Dial dual-encoder hardware doesn’t support the CW paddle input jack while CTR2-Flex
hardware does
e The M5Dial’s speaker is used for sidetone on CTR2-Dial hardware — it’s pretty quiet

NOTE: If you update your CTR2-Dial v1 firmware to CTR2-Flex v2, your CTR2-Dial settings will be
converted to the new file format when you run CTR2-Dial firmware from the Settings menu.

Which firmware you use will depend on your use case.

Power Options

CTR2-Flex hardware can be powered from the computer’s USB port, and iOS device’s accessory jack
using an OTG adapter (also referred to as a Camera Adapter), directly from a newer iOS device with a
USB-C cable, a 5-volt cell phone charger, a USB battery pack, an external 6-to-36 VDC power source, or
even an internal 3.7-volt lithium battery pack.

In the photo below, CTR2-Flex is connected to an OTG adapter on an iPad running SmartSDR for iOS. This
adapter has a USB-C power port and a Lightning connector that plugs into the iPad. The phone charger
plugged into the OTG adapter is optional and powers both the iPad and CTR2-Flex when plugged in. For
extended battery operation, a 20,000 mA USB battery can be used to power both CTR2-Flex and the
iPad. You can power CTR2-Flex directly from the iPad or iPhone through the OTG adapter without an
external power supply. Both CTR2-Flex and the iPad must be connected to the same network your radio
is on.

The green power jack on the back of the M5Dial allows you power the unit from an external 6-to-36 VDC
power supply. This connector is provided with assembled CTR2-Flex units but no external power jack is
provided.

CAUTION: If you power your CTR2-Flex from an external power supply (+6 to +36 volts into the green
connector on the back of the M5Dial), DO NOT connect the CTR2-Flex to a USB connector on your
computer at the same time. Your external power supply’s ground may not be at the same potential as

the USB ground and the voltage difference may damage your computer.
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Using a 3.7-volt Lithium Battery

The M5Dial also has a 1.25mm two-pin connector under the STAMP-S3 processor that is used to connect
a single cell 3.7-volt lithium battery. The M5Dial will charge the battery (at around 100 milliamps) so a
battery of at least 1000 mAH should be used. The STAMP-S3 processor must be removed to access this
connector and it can be very difficult to replace the processor when you’re done. This is a user
modification. | do not sell battery equipped CTR2-Flex units.

NOTE: When powering the unit using a 3.7-volt lithium battery you must press and hold the M5 button
for at least 10 seconds to wake the unit up when using the sleep timers or power off option in the

Settings menu.

CAUTION: If you choose to connect a 3.7-volt battery to your M5Dial you MUST verify the battery
connector is wired correctly! There is no standard for the + and — power leads on these batteries and
there is no reverse polarity protection on the M5Dial. If you connect the battery in reverse, you will
probably destroy the M5Dial. For more information see this post:
https://github.com/m5stack/M5Dial/issues/14
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CTR2-Flex Features

CTR2-Flex is based on the M5Dial from M5Stack. It features an ESP32-S3 processor and includes the
following features:

1.28” color touch screen with built-in selector ring and hardware pushbutton
WiFi connectivity — connects directly to the radio
Multiple CTR2-Flex units can be connected to the same radio, to the same slice or different
slices
Works with any version of SmartSDR (Windows, iOS, or MacOS)
CTR2-MIDI or CTR2-Dial MIDI controllers can be used in SmartSDR for iOS/MacOS apps at the
same time
Works in standalone mode without SmartSDR
Two user interface modes
e Menu pages provide easy to use controls if you just want to control one or two items
e Dashboard pages provide a small control surface for your radio with easy access to all
functions

42 virtual button controls for modes/bands/filters selection
30 virtual Dial (wheel/slider) controls for tuning, volume, RIT, XIT, etc.
Assign the gray Ring encoder on the M5Dial display to any of the available Dial controls
Up to two optional physical encoders (referred to as Knobs)
e Map 12 of the Dial controls to the Knob for single encoder units
e Map 6 of the Dial controls to each Knob in dual encoder models
e Knob push switches can be mapped to virtual button function
VFO Lock control
3.5mm (1/8”) stereo input jack allows you to use your paddles to control the keyer, straight key,
or PTT over the network connection
Nine CW macros
Swipe tuning and parameter adjustments on the Dashboard pages
Panadapter control
Control any slice, A through H, depending on radio’s capacity
Adjustable filter controls — adjust low-cut, high-cut, and offset independently
Speaker with volume control for sidetone
A virtual PTT switch or hardware PTT switch
Keypad for direct frequency entry (press Frq on the dashboard Home page)

Favorite frequency lists for each band

Speed sensitive controls

Adjustable virtual Dial sensitivity

Seven color themes and backlight control

Sleep and power down timers to save battery power
Manual power down

Multiple Power options

Backup CTR2-Flex’s settings using the Import and Export Settings option
Easily switch between CTR2-Flex and CTR2-Dial firmware
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Hardware

CTR2-Flex hardware is based on an M5Dail touch screen controller. It supports up to two physical
encoders with push switches, has a 3.5mm (1/8”) stereo jack to connect your CW paddle, straight key, or
external PTT switch, a volume control for sidetone level, and an internal speaker for louder sidetone
volume.

This is photo, the CTR2-Flex hardware is installed in a commercial,
injection molded, CNC milled New Age enclosure. The M5Dial is
mounted on the left and the encoder knob is on the right. The USB-C
and 3.5mm (1/8”) stereo Paddle Input jack connections are on the
rear of the enclosure and the sidetone volume control is accessible
through a hole on the back-left side. Rubber boots are provided to
tilt the enclosure for better viewing and control.

A 3D printed enclosure designed by Neil, GZUFOQ, is also available. This
enclosure is well suited for desktop use and looks nice in any station. It is
available in a single or dual encoder model. Both include a with 3.5mm
(1/8”) paddle jack.

Sidetone Volume Control

CTR2-Flex has a small speaker with a volume control for sidetone. The
volume control can be changed with a 1/8” (3.2mm) Phillips screwdriver
through a 1/8” hole in the side of the enclosure. The location of this hole depends on the enclosure type

and the number of encoders.

Enclosure # of Sidetone Volume
Type Encoders Location

New Age Right-rear corner

New Age 2 Front-center
3D Print 1 Front-right
3D Print 2 Right side
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CTR2-Flex - vs - CTR2-Dial Hardware

CTR2-Flex and CTR2-Dial controllers look and operate almost the same. The major difference is internal.

CTR2-Dial uses the two I/0 ports on the M5Dial for discreet devices, i.e. you
can have one encoder and a CW paddle jack installed or two encoders
installed. Also, the encoders on CTR2-Dial_ do not have push switches so you
can’t assign button functions to the knob switches.

CTR2-Flex on the other hand has a port expander PCB plugged into the
M5Dial’s Port A and a sidetone speaker circuit plugged into Port B. The port
expander PCB supports up to two encoders with push switches, and the CW
paddle jack. You can assign a button function to each encoder switch.

A volume control is provided to adjust the volume of the sidetone. It is
accessible through a 1/8” (3.2mm) hole in the side for the enclosure.

Initial Startup

There are a few tasks you must perform before your CTR2-Flex will be ready to control your radio.
Enter your Call and Registration Key

You must enter your call and registration key for your firmware using a terminal if built your own
hardware and purchased the M5Dial separately. Registration keys are provided for free and installed
when you purchase any kit or assembled unit from me or Neil. Users who prefer to source their own
parts can purchase a registration key for the firmware at a minimal cost.

NOTE: Registration keys are issued based on your call sign. Once registered you can use your key on any
M5Dial based Lynovation product (CTR2-Dial and CTR2-Flex).

The firmware will run in Demo mode until registered. In this mode, the unit will automatically power
down after 15 minutes. You can edit the settings and labels on the unit but you can’t save or export
them.

To enter your registration key, connect your unit to a terminal program such as Tera Term or Putty (see
Appendix B or C, or to the terminal in your Mac, Appendix D). Once connected, press any key to start the
terminal server on the unit. Next, press the Del or Backspace key on the keyboard. Enter the call sign

you registered and the registration key you received from me. The registration key is 8 hexadecimal
digits (0 to 9 and A to F). Once registered, your call sign will appear on the splash screen at boot up, the
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program won'’t shut down after 15 minutes, and you’ll be able to save changes in the maps and import
or export backup files. You call will can also be automatically inserted into CW macros using the A
prosign.

Factory assembled units have the unit’s Bluetooth name (CTR2xxxx), your call, and your registration key
written on the unit’s bottom label. They are covered with a piece of transparent tape so they don’t rub
off. This way you’ll have them if you reset your unit back to factory settings.

The terminal server can also be used to edit the CW macros, your router’s SSID and password, and your
radio’s IP address and IP port#.

Select the Number of Encoders

Once you have successfully registered CTR2-Flex firmware the Settings menu will open on page 4 so you
can select the number of knobs (encoders) on your unit. Your options are None, One, Two, and Swap
A/B (for dual-encoder 3D printed enclosure units).

Connecting to your radio

CTR2-Flex connects directly to your radio on your network using WiFi. Network credentials (router SSID
and password) can be entered from a terminal or directly by selecting SSID: and PW: on page 6 of the
Settings menu. Text input is tedious in the text editor. Turn Knob A to select a character then press and

turn Knob A to advance to the next character. To minimize frustration, use the terminal interface to set

these parameters. You will also need to set Flex Adrs: on page 7 of the Settings menu. This can be found

on the Settings -> Radio Setup -> Network tab in SmartSDR for Windows or on the Available Radios
popup window in SmartSDR for i0S/MacOS. The default IP port for the Flex radio is 4992. You can
change this if it has been changed on your radio with the Flex Port: option.

If you would like CTR2-Flex to automatically connect to your radio when it boots, turn AutoConn: ON.
You can temporarily disable auto-connect by holding the M5 button on the M5Dial down during boot.

Once your WiFi credentials and the radio’s IP address have been entered, select Connect WiFi on page 6
of the Settings menu to connect CTR2-Flex to your WiFi system. Once connected, CTR2-Flex can be used
as a control surface for SmartSDR or it can operate your radio as a standalone controller.

NOTE: Always connect the CTR2-Flex to your radio after starting SmartSDR so it connects to SmartSDR as

a non-GUI client that is linked to SmartSDR. If you connect it before starting SmartSDR v3.xx with

multiFlex enabled, it will create a second GUI client and will work separately from SmartSDR. SmartSDR
2.xx will not be able to connect to your radio if CTR2-Flex is already connected.

Multiple Clients

The server in your Flex radio supports multiple clients. This means that you can have several devices
connected to, and controlling it, at the same time. For instance, you can have SmartSDR for iOS
connected as a GUI client, one or more CTR2-Dial units connected to your iPad controlling the SmartSDR
app, and one or more CTR2-Flex units connected to the radio as non-GUI clients. CTR2-Flex units can be
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connected to the same slice or to different slices. Any change on any of the connected devices will be
sent to all the other clients subscribed to that slice.

TX Enable

While the Flex radio supports multiple slices, only one slice can be designated as the transmit slice. On
SmartSDR this is done by clicking on the TX button on the slice flag.

X ‘ %
21 1EB1LOO 21.196.000

e T R T At 5 L s - 9dEmE
| <) | psp | use | xmrm | DAX | | ) | psp | cw | xR | DAX |

Channel: (None v Channel: (None v

CTR2-Flex allows you to toggle the transmit state of the slice using one of these methods.

e Touch the bottom-left TX button on the dashboard’s TX page.
e Touch the Tx Enbl button on page 4 of the Buttons menu
e Assign the Tx Enbl button to one of the knob switches

When transmit is enabled on the slice CTR2-Flex is controlling, the caption on [ m

all windows is displayed in red font. ANTI 1om 27k

28 07 4
When using multiple CTR2-Flex controllers this allows you to easily identify 28.074.000

which controller is controlling the transmitter on your radio. RX Uss DsP
TX XRIT Misc

Using an External Keyer and/or Hardware PTT Switch

Many users may want to use an external keyer and/or an external PTT switch with their CTR2-Flex. This
can be easily accomplished by changing the following configuration options in the Settings menu.

e Wire the external keyer (or straight key) to the Tip and Shield of a 3.5mm (1/8”) stereo plug
e  Wire the external PTT switch (foot switch, hand switch, etc.) to the Ring and Shield of the same
stereo plug
e In the Settings menu:
o On page 2 select Momentary or Latch for PTT: - this determines the PTT action
o On page 5 select Passthru for the (paddle) Type: - this passes the paddle jack’s Tip input
to the CW Key function and the Ring input to the PTT function
e Enable TX on the slice you're controlling — this can be done in the Button menu or in the TX
page in the dashboard
e To enable CW keying, select CW mode and enable Breakin in the dashboard’s Misc menu
e To enable PTT, select a voice mode in the dashboard’s Mode menu
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User Interfaces

The CTR2-Flex firmware supports two user interface models. The first (left screenshot) uses simple
menus to select controls and buttons, similar to CTR2-Dial, and will be described next. Use this interface
when you just want to use your CTR2-Flex to control one or two parameters. The second user interface
(right screenshot) is a fully functional dashboard that allows you to easily select and modify parameters.
Go to the Dashboard section for a full description of that user interface.

P sice: N

ANT1 10m 27k

Dial Buttons

Knob

28.074.000

RX Use DSP
TX XARIT Misc

Menu Ul Dashboard Ul

DashBrd PTT

Menu User Interface

CTR2-Flex’s Home page allows you to open the control pages in the basic user interface. This interface is
the same interface used on CTR2-Dial with the addition of the DashBrd button.

e Dial opens the Dial control. This is a virtual dial where you can select from 30 different
parameters to control. Once selected, just swipe your finger around the perimeter of the display
to change the parameter. To change the parameter to control, turn the gray ring on the M5Dial
or touch the center label to open the Dial menu.

e Button opens the Buttons menu where you can select from 36 functions on six menu pages.
Turn the gray ring on the M5Dial to change menu pages or touch the left or right side of the
bottom button to switch pages.

e Knob opens the Knob menu where you can assign Dial controls to the external encoder. If you
have a dual-encoder CTR2-Flex unit there will be a Knob A and a Knob B button on the Home
page.

e DashBrd opens the Dashboard user interface that is described in this section.

e PTT opens the virtual PTT page where you can control PTT on your radio by simply touching the
display.

e Settings opens the Settings menu where you can change the configuration of many of CTR2-
Flex’s parameters.
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Dial Control

The virtual Dial control supports 30 controls. Swipe your finger around the
outer ring to adjust the control.

Turning Knob A (or Knob B on a dual-encoder unit) while in the Dial Control EREETY
will also adjust the value of the control if the Knob setting is set to default. W

If the gray ring on the M5Dial is in navigation mode, turn the ring to switch dial

controls. Otherwise, touch the dial # (1 in this example) to open the Dial menu
where you can select a dial function from 5 pages of menus.

Control options, if any, will be displayed at the bottom. In this VFO example, v 100 ~ controls the
frequency tuning step. Touch to the left or right of 100 to change the tuning step.

The VFO display also has a Zero button. Touch this button to zero the digits below the tuning digit.

Other controls such as Volume, NB, NR, RIT, and others have On/Off options. Touch the control at the
bottom of the display twice to toggle the option.

Dial Graphics
The Dial’s background depends on the selected control.

The lead photo in the Dial Control section shows a tuning control. Tuning controls are continuously
variable and used for VFO tuning. The tuning ring is the background color of the selected theme. The
label in the middle (in this case VFO) indicates the control function. You can not edit the control’s label.

There are two other control displays. These controls are similar to potentiometers and have a minimum
and maximum range.

For most controls like volume, squelch, etc., the outer touch ring on the Dial v
control represents a gauge with the level indicated by the filled portion. Like a AR
potentiometer, the gauge starts at 0% on the lower left and progresses 2
around the display to 100% on the lower right. The Volume control on the Volume

right is set to 55%. 55%
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Controls with positive and negative offsets, like RIT, XIT, and Balance controls
use a slightly different display. The Dial graphic for this control displays the +/-
offset referenced to the top of the dial. For negative offsets it grows to the 14
left and for positive offsets it grows to the right from center. The amount of RIT>
offset (in this case RIT frequency) is shown under the label. When the control 2200

v
DIAL

is offset, touch the label to reset it to 0 offset. If a control has an

enable/disable or zero option it will be displayed at the bottom of the dial. RITisON _

Touch this button to operate the control.

Shortcut: Touch to the /eft of the DIAL caption at the top to open the Knob menu. Touch to the right of
the DIAL caption to open the Buttons menu. Similar options are provided on the Knob and Buttons
menus.

VFO Control

When the VFO control is selected the frequency and frequency step will be
displayed in the center of the control. Touch any digit in the frequency to
select that digit as the tuning step. The step digit will turn red. Touch it again
to select the half-step.

For example, touching the 100’s digit (1) in the example at the left switched
the frequency step from 100 Hz to 500 Hz. Half-steps are indicated by
highlighting the digit to the left in magenta.

You can also press and hold, then turn Knob A while in this control to change the frequency step. You

can also touch the left or right side of the bottom ” xxx v button twice to change it.

Pressing the Zero label in this control will zero all of the digits below the frequency step digit.

Hint: You can quickly change to the Button or Knob menus from the Dial control by swiping across the
center of the display either left or right. Swipe from the left to open the Knob menu or from the right to
open the Buttons menu.

VFO Lock

To lock VFO tuning to prevent inadvertent changes simply long-press the

frequency on the VFO dial control or on the Dashboard Home page. When the
VFO is locked, the frequency will be “grayed out” as shown here. Adjusting ,
the tuning, or turning a knob assigned to the VFO, will post a message with 14.230.0 00
instructions on how to reset the lock. '

To unlock the VFO, long-press the frequency digits.
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Ring Control Options

The encoder used in the gray ring control on the M5Dial display is a detent (bumpy) encoder with 12
“clicks” per rotation. Because it isn’t very sensitive, and somewhat difficult to turn, it has only been used
for selecting dial controls and menu pages (i.e. navigation).

By user request, beginning with v2.02 I've added the ability to choose from several ring control options
with the Settings menu’s Ring option on page 8.

e Navigation mode — (default) — use the ring to select dial controls and menu pages.

e Sync2Dial mode — the ring adjusts the dial control selected in the Dial menu or on the Dial
control— this works in any page, similar to how the knobs work.

e Selected Dial Control — the ring adjusts a dial control that you select from the Ring Ctl menu.
This also works from any page.

The selected ring mode is indicated by a %-circle dot next to the WiFi antenna icon at the top of each
page. No dot indicates the ring control is in Navigation mode. A dot to the /eft of the antenna indicates
Sync2Dial ring mode is active. A dot on the right side of the antenna indicates a selected dial control is
assigned to the ring control.

'SETTINGS‘ 'SETTINGS‘ 'semue“s‘

Navigation Mode Sync2Dial Mode Selected Dial Ctl Mode

NOTE: When Navigation mode is not selected you must use the on-screen navigation controls to move
between menu pages and select Dial controls.

The following screenshots should help explain the process of selecting a ring control option.

Navigation mode

The screenshot at the right shows that the ring is in Navigation mode. | m

Xvtr Mode: Off

In this mode, turning the ring will change menu pages or the selected

dial control. Rotate Screen

No %-circle dots are shown at the top of the display. Ring: Navigation

Touch the Ring: Navigation button to switch to Sync2Dial mode. im .
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Sync2Dial mode

e TTINGS

In Sync2Dial mode the ring controls the currently selected Dial Xvir Mode: Off

control from any page, similar to how the Knob controls work.
Rotate Screen

Note the ¥:-circle dot is on the /eft of the antenna icon at the top. Ring: Sync2Dial

Touch the Ring: Sync2Dial button to open the Ring Ctl menu.
Ring Ctl Menu

The Ring Ctl menu is similar to the Dial menu and is used to assign

one of the dial controls to the Ring control. There are three pages of
menus. Use the Next button on the bottom to step to the next page. j AGC-T
Touch a control label to assign that control to the Ring control. In this Volume Moni

example, the VFO control is selected. Squelch Balance

Press Esc to return to the Sync2Dial mode without selecting a control. W

Selected Dial Control Mode

Once you select a control in the Ring Ctl menu you will return to the

Settings menu and the Ring: option will show the selected control.
Xvtr Mode: Off

Note the %:-circle dot is on the right of the antenna icon at the top. Rotate Screen

To return to ring Navigation mode, touch the Ring: button again. Ring: VFO

Dial Menu

Touching the dial # or the center of the dial display (except for the VFO

display) will open the Dial menu. The current dial setting will be highlighted
(VFO in this example). Touch a button to select that function and return to the : AGC-T
Dial control page. Touch the selected function to return to the Dial control Volume Moni

without changing the selection.

Squelch Balance

If the gray ring on the M5Dial is in navigation mode, turn the ring to switch W
pages. Otherwise, touch to the left or right on the footer button (<1/4>).

The caption button (DIAL MNU) is a two-function button.

e Touch the /eft side to switch to the Knob menu.
e Touch the right side to switch to the Buttons menu.

To prevent unintended operation, the caption button requires one touch to select the function
and one touch to execute the function.
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The dial functions are described in the following table.

VFO Slice freq control NB-Lv Noise Blanker Lvl HPh-Gn | Headphone Gain
Volume | Slice volume NR-Lv Noise Reduction Lvl Speed Keyer Speed
Squelch | Slice squelch ANF/APF | Auto Notch/Peaking | Weight | Keyer Weight
AGC-T AGC-Threshold RIT Rx Increment Tuning | Delay Dropout Delay
Moni Monitor level XIT Tx Increment Tuning | Zoom Panadapter Zoom
Balance | Left/Right balance PwrOut | Tx Power Out PanMax | Panadptr Max Level
Hi-Cut Filter high cut freq TunOut | Tune Power Out PanMin | Panadptr Min Level
Lo-Cut Filter low cut freq VOX VOX Level PanAvg | Panadptr Average
Offset Filter high/low offset | Mic-Gn Mic Gain PanGn Panadptr Gain
WNB-Lv | Wide Noise Blanker LnO-Gn | LineOut (Spkr) Gain PanBlk Panadptr Black Lvl

Hint: Quickly change to the Knob or Buttons menus by swiping across the center of the display either
left or right. Swipe from the /eft to open the Knob menu or from the right to open the Buttons menu.

Knob Menu

When your unit is equipped with one encoder (Knob A), any of 12 knob : KNOB Pg1
RIT * Zoom

functions can be assigned to it. If you unit is equipped with two encoders
(Knob A and Knob B), each knob can be assigned one of 6 functions. This is VFO WPM

done on the Knob page.
Pag AGC-T ,
The first option (with the asterisk *) always displays the current Dial Control A v

setting (RIT in this example). When this option is selected, turning the Knob

will change the parameter selected in the Dial Control. When you change the parameter the Dial
control’s is set to, the knob’s “*” function will follow.

Selecting one of the other five functions on this page assigns that function to the Knob and it will be
controlled independently from the Dial Control.

To prevent unintended operation, the caption button (KNOB Pgl) is a dual-function button and requires
a select and execute touch.

e Touch the /eft side to switch to the DIAL control.
e Touch the right side to switch to the Buttons menu.

If the gray ring on the M5Dial is in navigation mode, turn the ring to switch pages. Otherwise, touch the
footer button (Pg->).

Hint: Quickly change to the Buttons menu or Dial control by swiping across the center of the display
either left or right. Swipe from the left to open the Buttons menu or from the right to open the Dial
control.
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Editing the Knob Menu
You can easily change the functions available in the Knob menus. Just touch a

function to select it then touch it again to edit it. The selected function and ‘e KNOB A
the bottom button will turn red. Turn Knob A to scroll through the functions

VFO * AGC-T

available in the Dial menu.
VFO Zoom

Touch the < Select > button on the bottom or let the select timer timeout (3 Volume Speed
seconds) to save the new setting.
< Select >

NOTE: The first function (*) is changed by changing the Dial Contrtol’s
selection. It cannot be changed in this menu.

The KNOB display overwrites the current page anytime the knob is
adjusted. The display is identical to the DIAL page but the colors are
inverted. The current page re-appears 750 milliseconds after you stop
turning the knob.

Buttons Menu

Open the BTN MNU to select from 42 button functions. Touching a

button immediately sends that control to the radio. y m

Mode A Band 2
There are 7 pages of buttons with six buttons on each page. If the gray

Modev Bandv

ring on the M5Dial is in navigation mode, turn the ring to select a page,
otherwise, touch the left or right side of the bottom label to decrement Mue iind

or increment the page #.

To prevent unintended operation, the caption and footer buttons are
dual-function buttons. The first touch selects the button and the second
touch executes the selected function. Press the M5 button on the

orange ring to return to the Home page.

To prevent unintended operation, the caption button (BTN MNU) is a dual-function button and requires
a select and execute touch.

e Touch the left side to switch to the Knob menu.
e Touch the right side to switch to the Dial menu.

Hint: Quickly change to the Dial control or Knob menu by swiping across the center of the display either
left or right. Swipe from the left to open the Dial control or from the right to open the Knob menu.
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Assigning a Knob Switch to a Button Function (CTR2-Flex Hardware Only)

To assign a button function to each knob’s (encoder) switch, do the following:
e Open the Buttons menu and navigate to the page with the function you want to assign
e Press and Hold the Knob switch you want to use
e Touch and release the function button you want the Knob switch to execute

Once you have assigned a function to a Knob, the knob’s letter will appear in that button’s label
and that function will be sent to the radio anytime you press that Knob. The photo above shows
Knob A’s switch assigned to Band A and Knob B’s switch assigned to Band v. If your CTR2-Flex
unit only has one Knob, you’ll only be able to assign a function to Knob A.

To unselect a function, hold the Knob switch down and touch the selected function again.

PTT Page

The PTT page offers a virtual PTT button. There are three options to choose
from on this page. Touch the bottom button to step from PTT Off, PTT
Momentary, and PTT Latch modes.

Touch to

When PTT is Off, touching the screen has no effect.

When PTT is set to Momentary, touching the screen keys the radio’s PTT over

the network. Lifting your touch unkeys the radio.

When PTT is set to Latch, touching and releasing the touch keys the radio over the network. It will
remain keyed until you touch and release the screen again or the three-minute timer expires.

Using a Hardware PTT Switch

To configure an external hardware PTT switch, see Using an External Keyer and/or Hardware PTT Switch.

Settings Menu

To enter the SETTINGS menu, press the Settings button at the bottom of the m

Home page.

PTT: OFF
The settings menu is divided into 10 pages with three buttons on each page. Theme: Blue
You must press a button twice to change its setting.

Backlight: Med1

Press the M5 button or touch the SETTINGS caption to return to the Home
page.

If the gray ring on the M5Dial is in navigation mode, turn the ring to select a page, otherwise, touch the
left or right side of the bottom label to decrement or increment the page #.

The table below summarizes each setting.

CTR2-Flex Operation Manual v2.02 Page 22



Page

Btn

Function

Description

Beep Mode

Changes the volume of CTR2-Flex’s button beeps. Range: Off,
Low, Medium, and High. Sidetone volume is set through a small
hole in the enclosure using a 1/8” (3.2mm) Phillips screwdriver.

Speed Tune

When enabled, touch and hold the outer ring on the Flex for > 1
second to enter speed tuning mode. Valid for VFO control only.

Dial Sens

Changes the sensitivity of the virtual Dial. Range: Low, Medium,
High. Default is Medium.

PTT

Changes the PTT mode from Off -> Momentary -> Latch. This can
also be changed on the PTT page by touching the bottom button.
This option also controls keying PTT with a hardware PTT switch.

Theme

Select the color theme for the selected Map. Options include
Dark, Light, Blue, Orange, Green, Red, and Violet.

Backlight

Adjusts the backlight. Range: Low, Medium1, Medium2, and
High. Lower settings reduce current draw on the unit.

Sleep

Sets a timer that turns off the display backlight after no activity
for the set number of minutes to reduce current draw. Sleep
mode does not close USB or Bluetooth connections. Range:
Never, 1, 5, 10, 30, and 60 minutes.

Pwr Off

Sets a timer to turn off the unit after no activity for the set
number of minutes. Pwr Off mode reduces current draw to 14
microamps and closes USB and Bluetooth connections. Range:
Never, 10, 30, 60, 120, and 180 minutes.

Power Down

Immediately closes the WiFi connection and turns off the unit
reducing current draw to 14 microamps.

# Knobs

Selects the external knob (encoder) options. Available options
are determined by the interface hardware.
e Options are None, One, Two, or Swap A/B (for two knob
units)
e When this firmware is running on CTR2-Dial hardware
the paddle jack is only available in the None and One
options.

Knob/Knob A

Selects Normal or Reverse direction for Knob A. Default is
Normal.

Knob B

Selects Normal or Reverse direction for Knob B. This option only
appears if two knobs are selected in # Knobs

(Keyer) Type

Selects the internal keyer type. Options are Off, Straight,
PassThru, lambic A, lambic B, Ultimatic, and Bug — does not
change radio keyer. Use Passthru for external keyers or PTT
switches.

Pitch

Selects the sidetone frequency for units supplied with CTR2-Flex
hardware. Has no effect on CTR2-Dial hardware. Options are Off
and 500 Hz to 1000 Hz in 50 Hz steps.

Paddles

Select Normal or Reverse paddle wiring

CTR2-Flex Operation Manual v2.02

Page 23



Fav Mode

Switches the Favorite Frequency list between all bands and
single band

Xvtr Mode

Indicates whether transverter mode is On or Off. Transverter
mode is automatically enabled when XVTA or XVTB are selected
in the dashboard’s Ant menu. When transverter mode is enabled
2m, 1.25m, 70cm, 33cm, and 23cm bands are added to the Band
menu and the frequency display is slightly compressed to display
the additional digits.

Future

Future option

Connect/
Disconnect WiFi

Connects or disconnects WiFi. You must have the router’s SSID
and password and the radio’s IP address and IP port # set before
connecting to the radio.

SSID

Set router’s SSID. Touch to open the screen editor or use a
terminal program connected to CTR2-Flex to set the SSID.

PW

Set router’s password. Touch to open a screen editor or use a
terminal program connected to CTR2-Flex to set the password.

AutoConnect

Enable or disable WiFi auto connect. When enabled CTR2-Flex
will try to connect to the WiFi network when it is first powered
up. You can override this setting by pressing and holding the M5
button during boot.

Flex Adrs

Set the radio’s IP Address. Touch to open the screen editor or
use a terminal program connected to CTR2-Flex to set the IP
address. The address can be found in the Settings -> Radio
Setup... ->Network tab in SmartSDR.

Flex Port

Set the radio’s IP Port. Touch to open the screen editor or use a
terminal program connected to CTR2-Flex to set the IP port #.

This is normally 4992 but you can change if you’re changed it on
the radio or are connecting to the radio from outside your LAN.

Import Settings

Import settings from a previously exported setting file using
XModem. In Tera Term select File->Transfer->XMODEM->Send
and select a previously saved settings file on your computer.
Next, touch Import Settings to start the transfer. See the Backing
Up and Restoring Setting section for more information.

Export Settings

Backup CTR2-Flex’s settings by exporting them to a file on your
computer. To do this, in Tera Term select File->Transfer-
>XMODEM->Receive then enter the name of the file you wish to
save. Next, touch Export Settings to start the transfer. Once this
file has been saved you can recover from a unintended memory
erase when flashing new firmware by using the Import Settings
option above.

Info

Displays version #, call sign, and registration key. If the unit is
connected to WiFi the RSSl is displayed too.

10

Ring Mode

Selects the operating mode of the gray ring on the display. See
Ring Control Options for a complete discussion on Ring modes.

Rotate Screen

Rotates the screen 90 degrees for each selection. This allows the
screen to be aligned for various M5Dial mounting configurations.

Touch Delay

Enables or disables a 120-millisecond delay on touch input. This
can be used to reduce unintended touch events and occasional
randomly generated touch events from the M5Dial touch sensor.
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Run CTR2-Dial

Select this option to switch to CTR2-Dial firmware on your unit.
CTR2-Dial uses Bluetooth or USB MIDI to control a 3™ party app
such as Marcus’ (DL8MRE) SmartSDR for iOS/Mac. It is not
compatible with SmartSDR for Windows. For more information
on CTR2-Dial refer to the CTR2-Dial Operation Manual.

Restore to Start
Up

This option allows you to reset your settings to what they were
when you first booted CTR2-Fle, if you didn’t choose to reset
your call and registration key in Reset to Factory. This is handy in
case you want to “roll back” changes you made during the
current session.

Demo Mode:
Edit Call & Key

Normal Mode:
Reset to Factory

In Demo Mode:

This option allows you to enter your call and registration key
without using a terminal program. To enter text, use the ring
encoder on the M5Dial or turn Knob A to select a character and
touch the display or press and turn Knob A to move to the next
character. Press OK to accept. You can also connect a terminal
program and use the terminal keyboard to enter your call and
registration key.

In Normal Mode:

This option resets CTR2-Flex’s configuration back to the original
factory settings.

NOTE: You have the option of resetting your call sign and
firmware registration key.

NOTE: If you reset the configuration by mistake, and didn’t
choose to reset your call and registration key, execute the
Restore to Start Up option to restore your settings before
powering the unit down.
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Dashboard

CTR2-Flex includes a second method to control the radio called the Dashboard. To enter this mode,
select DashBrd from the Home menu.

Dash Home Page
The dashboard’s Home page displays the frequency along with B
buttons to select various command groups. m

ANTT 10m 27k
The small inverted triangle above the caption indicates CTR2-Flex is

28.074.000

connected to WiFi and the radio.
RX usB DSP

When online the caption will display the active slice. Touch the
TX XMARIT Misc

caption to open the Panadapter window to change the active slice.

Touch any element on this page to select or execute that item or
open its associated menu.

Knob A always changes the selected parameter (with the box around it). If you have a dual-encoder unit,
Knob B can be programmed to change any of the dial controls in the Knob B menu.

The VFO frequency is always selected on the Home page as shown here. Turning Knob A changes the
frequency by the selected step digit (the red digit, 100 Hz in this example). You can change the step
simply by touching another digit in the frequency or by pressing and holding the (A) encoder knob then
turning it CW or CCW. To select the % step (5, 50, 500, 5000, etc.) using the touch method, touch the
selected step digit again.

Swipe Method

When you touch the frequency box the selection indicator around the frequency display turns
red indicating that swipe tuning is enabled. To change the frequency, simply swipe your finger to
the left or to the right anywhere on the display. Swiping below the frequency is recommended
so you can see the frequency as you swipe. You can raise your finger and swipe again as long as
the select indicator is red. Swipe mode will automatically turn off after 3 seconds of inactivity.
Slider functions in the dashboard also use this method of adjustment.

To zero the digits below the selected tuning digit, double-touch Zero at the bottom of the display.

NOTE: If the VFO is locked, all frequency digits will be “grayed out” and the Zero function will be
blocked. To unlock the VFO, long-press the frequency digits.

To return to the Home page, press the M5 button on the M5Dial’s orange ring.

Touching the other buttons on this page will open their page. These pages will be described next.
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Keypad Frequency Entry

CTR2-Flex has a built-in keypad to directly enter frequencies. To open the
keypad, press Frq on the left side of the bottom button on the dashboard’s
Home page.

The current frequency will be displayed on the top of the display in Hertz with
a keypad below.

You can edit the current frequency by pressing the < button to delete digits to
be replaced then entering the new digits. In this mode you must press the H button to accept the new
frequency in Hz so be sure to add any trailing Os needed.

To enter a new frequency, press the X button to clear the current frequency then enter the new
frequency. You can enter the frequency in MHz, kHz, or Hz. Once you’ve entered the new frequency
press the M, K, or H button to accept it. Use the < button to delete the last digit in the frequency.

Here are a few examples:

e Entering 10M sets the frequency to 10 MHz.

e Entering 28.074M sets the frequency to 28.074 MHz.

e Entering 28074K also sets the frequency to 28.074 MHz (28074 kHz).

e Entering 2807400H sets the frequency to 2.807400 MHz. Add another O to make it
28.074 MHz.

e Entering 28074020H sets the frequency to 28.074020 MHz.

Touch Fav on the bottom-left button to open the Favorite Frequency page from this page.

NOTE: If the VFO is locked this page is not available. Unlock the VFO by long-pressing the frequency
digits.

Antenna Page

The Antenna page allows you to select the antenna configuration on your ' Rxm
radio. Simply touch the antenna option you want to use.

ANT1 ANT2 XVTA
RX_A

Selecting XVTA (or XVTB on dual SCU radios) enables Transverter mode. This

mode adds the 2m, 1.25m, 70cm, 33cm, and 23cm bands to the Band page ANTI ANT2 XVIA

and compresses the frequency display to accommodate the additional digits.

The top half of this page displays the receive antenna options and the bottom
half displays the transmit antenna options. Touch a button to select an option.

When you’re done, touch the Esc button at the bottom of the page to return to the dashboard’s Home
page.
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Band Page

The Band button (top-center of the dashboard’s Home page) displays the current band setting on the
radio. Touch this button to open the Band page.

When either the XVTA or XVTB transverter options are selected in the Antenna page the 2m, 1.25m,
70cm, 33cm, and 23cm bands are added to the Band page.

160m 80m 60m 40m
30m 20m 17m 15m

2m 10m 6m 2m

125 70c 33c¢ 22¢

Normal Band Options Additional Transverter Bands

Touch Fav on the bottom-left button to open the Favorite Frequency page from this page.

Touch the Esc button at the bottom of the page to return to the dashboard’s Home page.

NOTE: If the VFO is locked this page is not available. Unlock the VFO by long-pressing the frequency
digits.
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Filter Page

The current bandwidth is displayed in the top-right corner of the dashboard’s

Home page. Touch this button to open the Filter page.
Hi-Cut: 3480

On this page you can change the Hi-Cut and Lo-Cut frequencies Lo-Cut
Offset: 40

independently and change the filter Offset to move the filter within the pass T —
band. The total bandwidth (3.3k) is indicated on a button at the center of the

4™ row. Touch this button to step the bandwidth down to the next standard v
bandwidth for the selected mode. If the filter offset has been moved off-

center (40 Hz in this example) the Zero button is displayed. Touch this button to remove the offset and

reset the filter to its default settings.

The selected control (with the blue square) can be adjusted with Knob A. You can also enable swipe
control by touching the selected control. The select indicator will turn red while swipe is enabled. In
swipe mode, simply swipe your finger on the display either to the left or to the right to change the
control. Swipe mode automatically turns off after 3 seconds of inactivity. Touching an unselected control
selects it. Touch it again to enable swipe.

RX Page
The RX page allows you to change several parameters related to the receiver.

Touch any control to select it. For variable controls, turn Knob A to change the
setting. You can also touch the selected control to enable swipe mode, then
swipe your finger left or right to change the parameter. The select indicator
will turn red while swipe is enabled. You can continue to swipe until swipe
mode times out (in 3 seconds).

Touch the AGC or Gain settings to step through the settings for those
controls.

The Volume control has a Mute function. Touch the Vol label to toggle mute on and off.

Touch ESC to return to the dashboard’s Home page.

Mode Page

The Mode button (center of the dashboard’s Home page, below the

frequency) displays the mode setting on the radio. Touch this button to open
the Mode page. CW L8 [uss
AM FM RTTY

In the Mode page, touch a mode to switch the radio to that mode and return

DIGL DIGU SAmM

you to the dashboard’s Home page. Touch Esc to return without changing the
mode.
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DSP Page

The DSP page allows you to adjust and enable or disable each DSP setting on r 3 m

the radio.

To adjust a setting, touch its gauge to select it then turn Knob A. You can also
use the touch to select then swipe method described earlier.

To enable or disable a control, touch the control’s label. When enabled the

control text will be inverted. Noise Reduction is enabled in this example. You
can also select the control’s gauge then touch the Tgl button to enable or disable that control.

Touch Esc on the bottom button to return to the dashboard’s Home page.
TX Page

Controls associated with the transmitter are accessed by touching the TX
button on the Home page.

PwRO 50|

You can adjust the Power Out, Tune Out, and Mic Gain by selecting those v O:IE

mcen: %8 |

ATU: TUNE Bypas

gauges.

Knob A can be used to adjust the selected parameter or you can enable swipe

method to change it.

Both ATU buttons require one touch to select the tune function then a second touch (on EXEC) on the
left-bottom button to execute it.

To toggle the TX mode on the current slice, touch TX on the left-bottom button. The state of the TX
mode is indicated by the caption of the page (TX in this example). When TX is enabled the caption on all
pages will be red. When TX is disabled the caption on all pages will be the default background color.

You can also open the Buttons menu to change TX mode on the radio. If you use it a lot you can assign
the Tx Enbl button on the Buttons page to one of the knob switches.

Touch Esc on the bottom button to return to the dashboard’s Home page.

X/RIT Page

Enter the X/RIT page by touching the X/RIT button on the dashboard’s Home
page.

As with the other control pages, select a control then use Knob A or the touch
to select then swipe method to change the control’s value.

Enable and disable the selected control by touching the control’s label or by

touching Tgl on the bottom button.
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When a control is not set at 0 Hz, a Zero button will appear below its gauge. Touching this button sets
the control to 0 Hz.

Touch Esc on the bottom button to return to the dashboard’s Home page.

NOTE: If the VFO is locked this page is not available. Unlock the VFO by long-pressing the frequency
digits.

MISC Pages

The Misc page contains several sub-pages. These pages include the Keyer Settings, CW Macro Selection,
Panadapt1/Slice Settings, and Panadapt2 pages.

Touch PG> on the bottom button (if available) or turn the gray ring on the M5Dial to move to the next
page.

These pages will be described next.

Keyer Setting Page

The keyer’s settings can be changed in this page. As in the other dashboard i m

pages you either use Knob A or the touch to select then swipe method to

change the selected value. Changing the Speed setting changes the speed for Speed] 17 |
. . . Delay__12% |

both the internal keyer on the radio and the keyer in CTR2-Flex. saTone] %0 |

Type: lam-A  Breakin

The radio’s sidetone can be enabled or disabled by touching the SdTone label

or the Tgl label on the bottom button. There is a physical volume control on W

CTR2-Flex hardware to adjust the sidetone volume.

NOTE: The radio’s sidetone is only available when your paddles are connected directly to the
radio and you’re using the radio’s internal keyer. It is not available when keying the radio with
CTR2-Flex over the network.

The Breakin button controls the radio’s breakin mode.

NOTE: To key the radio, you must have Breakin enabled (as shown in photo above) and the
current slice must have TX enabled. The caption will be red when TX is enabled.

Knob A can be used to adjust the selected parameter or you can enable swipe mode to change it.

You can step through the keyer Type by selecting Type then pressing the Chng label on the bottom
button or by pressing the Type label again once it is selected.

When SdTone and Type are not selected, touch Pg> on the bottom button to open the
Panadapter/Slice page. You can also turn the gray ring on the M5Dial CW to move to the next or
previous page.
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Marco Select Page

This page allows you to select, play, and edit one of the nine CW macros.
Macros are listed using the first 5 characters of each buffer. Touch a macro to
select it then touch Play to start it or Edit to edit it.

cqcq Tnxf qthi

name rigi sohw

. sohw Mac8 This

Once you start a macro the button options change to Pause, Stop, and Add.
Edit

Touch each button as required. Once a macro has started you can leave this :

page and let it run.

Touch Pg> on the bottom button or turn the gray ring on the M5Dial CW to
open the Panadapter/Slice Settings page or turn it CCW to open the Keyer Settings page.

Touch Esc on the bottom button or the M5 button on the orange ring to return to the dashboard’s
Home page.

Macro Edit Page

Pressing the Edit button on the Macro Select page opens the editing page for [ B
) MACRO #1
the selected macro. Féacaco de

cq cq cq de

e Turn Knob A to change the selected character * kil

e Touch any character to move the cursor to that character
- Or -

e Press and hold Knob A down then turn it to move the cursor to the

next character
e The A character is used to insert your registered call into the buffer
e Use the Ins and Del buttons to insert or delete a character
e Touch OK to accept the changes or Esc to exit without changing the buffer

NOTE: You can also edit the macros using a terminal such as Putty or Tera Term on a Windows PC or
the built-in terminal program in a Mac or Linux. Simply press the # of the buffer to edit (1 to 9) in the
terminal.

Panadpt1/Slice Page

The Panadpt1/Slice page allows you to change the ranges used on the
. . PANADPT1
panadapter and select which slice you want CTR2-Flex to control.
Zoom®k__ 30|

You can access this page directly from the dashboard’s Home page by PanMax] 40 |

Panttin 135 ]

Slicee A < >

touching the caption on the Home page.

The normal methods to change the selected value are available, i.e. turn Knob W

A or touch then swipe.
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To change the Slice, touch either the < or > button. The new Slice character will be displayed inverted.
To accept the change touch Chng on the bottom button.

To move to the Panadpt2 page touch the Pg> button or turn the gray ring on the M5Dial CW. To move
back to the Macro Sel page, turn the gray ring CCW.

Touch Esc on the bottom button to return to the dashboard’s Home page.

Panadpt2 Page

The second panadapter page allows you to control the Average, Gain, and
PANADPT2

Black levels on the panadapter and waterfall.
Panvg:__ 50|
The two buttons on the 4" row allow you to toggle Weighted Average and PanGn{_ 30 |

Auto-Black functions. PanBlk:[ 0 |

Wght Avg Auto Blk

These functions are also available on the virtual Dial control.
Favorite Frequency Page

Access the Favorite Frequency page by pressing Fav on either the Keypad or

Band page. This page displays 10 frequencies that you have visited. vy

707400 249150U*

In the Settings menu you can select to save frequencies from all bands to one 101360U° 280740 U*
list (shown in this screenshot) or you can have a favorited frequency list for 140740U" 50313.0U°

each band. \ 18100.0U* |140542C

D\Lock | Esc A

this list when you stop on a frequency for longer than 10 seconds. Modes are represented by their first
letter, U=USB, C=CW, etc.

Frequency and modes are automatically added to the first unlocked bin on

Lock a frequency bin by selecting it then touching Lock on the bottom-left button. Locked bins have an
asterisk to the right of the mode character. Once locked the bin will not be overwritten by new
frequency or mode data. This allows you to freeze your favorite frequencies and quickly return to them.
Unlock the selected bin by touching UnLk on the bottom button.

Touching any frequency bin will highlight that bin and automatically tune the radio to that frequency
and mode (if CTR2-Flex is online). The bin will be highlighted with a red outline for 3 seconds and Move
will appear on the bottom left button. During this time, touching Move will move the selected bin to the
top left position. This allows you to organize your frequency list.

Turn Knob A to move to another bin. Favorite frequencies will be restored after a power cycle. Once all
of the bins have been locked the list will not accept new frequencies.

Press Esc to return to the dashboard’s Home page.
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Backing Up and Restoring your Settings

Once you have your CTR2-Flex setup the way you want it, go to the Settings
page and Export your settings to a backup file on your computer.

Impornt Settings
CTR2-Flex uses the XModem file transfer protocol to transport settings to Expont Settings

and from backup files on your computer. XModem is an older protocol and
not many terminal programs support it anymore. Tera Term does and I'll use W
it in the document. Putty does not. To get XModem functionality with Putty i

you need to download and install ExtraPutty. This program is a branch off of
Putty. You can download it from here.

Before you can use the Import Settings option you must export the settings on your CTR2-Flex once
you’ve made changes. If you want to just return to factory settings, select the Reset to FACTORY option
in the Settings menu.

Export Settings

To export the current settings on your CTR2-Flex,

& COM11 - Tera Term VT

File Edit Setup Control Window Help

connect your terminal to CTR2-Flex then open its

MNew connection... Alt+N

XModem transfer utility. On Tera Term, open the Duplicetesession  AleD I

Cygwin connection Alt+G

Files->Transfer->XMODEM->Receive option shown
teg.. he Settings start
here. your terminal.
Import settings
Receive to Export

When you select this option Tera Term will ask you your computer.
to enter the file name for the file you want to Send fil..

. o . Transfer > Kermit >
create. Navigate to the folder you want to save it in e o =
then give it a name. | prefer to use the .txt extension renge decten- e A—

eplay Log...
but you can use any extension you want. e B-Plus >
>

k-VAN
TTY Replay G

Print... Alt+P

When you click OK Tera Term will open the
Disconnect Alt+]

XModem transfer window and wait for the transfer - e

Exit All

to start. At this point, touch the Export Settings

option in the Settings menu. The transfer should complete in a second or two and you should have a
new file in your backup folder. You can view this file with a text editor. | don’t recommend editing the
values in this file because invalid values may cause problems with CTR2-Flex’s program.

Import Settings

Now that you have a backup file of your settings you can import them at any time. This is handy if, for
instance, you select Erase in the EspressIF Flash Download tool. This will clear all the memory on your
CTR2-Flex including all of the setting files.

To import a settings file in Tera Term, navigate to the File->Transfer->XMODEM-Send option. Once
there, Tera Term will ask you to select a file from your backup directory. Select one of the files you
previously saved using the Export Settings option. Tera Term will then open the file transfer window and

CTR2-Flex Operation Manual v2.02 Page 34


https://sourceforge.net/projects/extraputty/
https://sourceforge.net/projects/extraputty/

wait for CTR2-Flex to tell it to start. Touch the Import Setting button to start the transfer. It should only
take a second or two. Once it completes CTR2-Flex will load the new configuration.

NOTE: Backup files from v1.xx firmware are not compatible with v2.xx firmware.

You can also use the XModem transfer option in

# COM11 - PuTTY

Extraputty as shown here. Use the Xmodem Optlon, Session  Special Command  Window Luggm Files Transfer Hangup 7

Ymodem
not the Xmodem 1K option. Hmodem Send
Xmodem 1K Receive
Zmodem
TFTP
FTP

R00:06:19 Connected  SERIAL/1152008 N 1  Error File not found !

Flex Radio CW Zombie Mode

Occasionally the Flex radio exhibits an odd problem when keying over the network. The radio can go
into what | call CW zombie mode. This happens occasionally when connecting and disconnecting
multiple clients to the radio that send remote keying commands (at least | think that’s what causes it).

In zombie mode the radio looks like it is transmitting CW, the light on the front panel turns red, the TX
icon turns red, the MOX button turns blue but no RF carrier is generated or displayed on the
panadapter. The only way | have found to get the radio out of zombie mode is to disconnect all clients
and power cycle the radio.
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Appendix A: Installing or Updating CTR2-Flex Firmware

CTR2-Flex firmware is pre-installed on assembled CTR2-Flex units supplied with the M5Dial controller. If
you’re using your own hardware you’ll need to install the firmware yourself.

UPDATE: EspressIF has released a browser-based version of their Flash Download tool named
ESPLaunchPad. You can use this version to flash firmware to your CTR2-Flex unit instead of downloading
and installing the Flash Download tool described here. For more information, visit
https://ctr2.lynovation.com/espressif-browser-flash-download-tool/

Download Button Reset Button

You must force the M5Dial into programming mode before you
can flash firmware to it. To do this, follow this procedure

1) Open the enclosure and locate the back of the M5Dail
a. On 3D printed enclosures remove the four screws
holding the base to the shell with a 2mm Allen
wrench
b. Onthe New Age enclosure remove the four rubber
feet on the bottom by pulling them off then
remove the four Phillips screws under the feet
2) Press and hold the DOWNLOAD (BTN) button on the M5Dial then apply power to CTR2-Flex. The
display will be blank when the unit boots into programming mode. If the unit is already powered
up, press and hold the DOWNLOAD button then press and release the RESET button. You should
hear a beep from your computer as it registers the new USB COM port and the display will be
blank.
NOTE: If you have problems getting the DOWNLOAD button to work its lever may have slipped
off the button on the board. Remove the label and flick the lever back onto the button. Thanks
Joe, KO8V for the tip!
3) You can now use the procedure below with EspresslF Flash Download tool (on Windows) or run
the script (on Linux and Mac) with the new COM port to flash the new firmware to the M5Dial.
4) Once the download completes, cycle the power on the unit to start the new firmware.

Now that you have the M5Dial in programming mode, follow these steps to install or update to the

latest CTR2-Flex firmware on

1. Download and unzip the latest CTR2-Flex firmware from my web site. Unzip that file into a
different folder than where you store other Lynovation firmware update files.

2. Download and open the EspressIF Flash Downloader Tool. When it =SSN
starts, select the ESP32-S3 Chip Type. Leave WorkMode set to
Develop and LoadMode set to UART. Chipfype:  ESP32:53 .
WorkMode: ~ Develop ¥
LoadMode: UART ]
oK
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3. Map the four .BIN files in the CTR2-Flex’s firmware distribution folder into the downloader tool.
NOTE: The address for each file is embedded in its file name. Enter these addresses in the
address fields to the right as shown in this
screenshot. The address must match the i SEiDowmicad |

[l ESP3253 FLASH DOWNLOAD TOOL V3.9.7

address in the file’s name. : : Z

] @

4. Select the checkboxes on the left of the four —» ot Z

.BIN filenames as shown. 0 @

O @

0 @

5. Set the COM: port to the port assigned to L — a
CTR2-Flex and set the Baud: to 921600. SPISPEED SPIMODE g Detectedinfo =

© 40MHz Oalo
0 26.7MH:z O aqout LockSettings
O2MHz  ©DIO CombineBin
8MHz  ODOUT
(O FASTRD

Default

DownloadPanel 1

CCN‘| COM6 v

BAUD: (921800 v

START STOP ERASE

6. On new installs, click the ERASE button to clear the factory demo from the M5Dial’s memory.
NOTE: If you erase the memory after running the CTR2-Flex firmware you will need to re-enter
your call sign and registration key the next time you start CTR2-Flex.

7. Click the START button to download the firmware.

8. Once the download is complete, cycle the power on the unit to start the new CTR2-Flex
firmware.

NOTE: The ESP32-S3 processor will revert back to its operating COM port after the reboot.
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Installing using Linux or Mac

On Macs you can use the browser based flash tool called ESPLaunchPad instead of using the script
below. For more information on this tool visit https://ctr2.lynovation.com/espressif-browser-flash-
download-tool/ Currently, Linux based browsers aren’t supported in this tool.

A script file is also supplied in the firmware update zip file. This script file can be used in a Linux or Mac
environment if you don’t have access to a Windows computer.

Instructions for using this script file are include in the CTR2-Micro Operation Manual in Appendix B.

The firmware that allows USB MIDI control changes the way the virtual COM port works on the ESP32-
S3. One COM port is used in the normal operating mode and another COM port is used for flashing the
firmware. In order to flash new firmware to the unit you must force the ESP32-S3 to switch from the
normal operating mode to programming mode.

To use the script file:

1) Force the M5Dial into programming mode as described above.

2) Edit the COM port in the script to the programming port. This port will be different than the
operating COM port.

3) Edit the path to the .BIN file in the script.

4) Run the script.

Appendix B: Configuring Tera Term
On Windows, Tera Term is the simplest terminal program to get running for a serial connection.

If you search for Tera Term you find a lot of garbage with malware attached to it. I've downloaded a
clean copy of Tera Term v4.106 and posted it in the CTR2 Group 10O files section. You can download it
here. As far as | know, Tera Term is only available for Windows.

Tera Term: New connection

When you first open Tera Term you’ll
. O TCPAIP
be presented with the Tera Term - TCH -
istory
New connection window. Simply Telnet 23
select the Serial radio button, select SSH SSH2
. . Other
the COM port Window’s assigned to AUTO
your Micro when you plugged it in,
. O serial Port: [COM3: Brother MFC-7660DW Remote |
and click the OK button. COM3: Brother MFC-7860DW Remote Setup Port [COM3)
COMA: FlexRadio Yirtual Serial Port [COM4
COM19: USB Serial Device [COM19

Since you are connecting to a USB rerremreTzse e COM104: FlexRadio Yirtual Serial Port (COM104)

serial port there is no need to set the baud rate. It will run at USB speed regardless of the baud setting.

That’s it! Tera Term should now connect to CTR2-Flex. Once connected, press any key to start CTR2-

Flex’s terminal server.
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You can change the terminal size in the Setup menu. Select Terminal... Set the Terminal Size to 41 x 20.
CTR2-Flex’s terminal interface was designed for this size.

While in the Terminal... settings verify the New-line options are set to CR for both Transmit and Receive
and the Terminal ID is set to VT100.

You'll probably want to change the font size and colors. These are also changed in Tera Term’s Setup
menu. Select Display to change the font and background colors to your liking. Select Font to change the
font and font size. | like Courier New, Regular, and 14 point size. You’'re preferences may differ.

Once you have the program configured the way you like, select the Setup->Save Setup... menu and save
your configuration. If you use the default file name, TERATERM.INI the program will automatically start a
Telnet session using the COM port you selected above when it opens. This provides one-click access to
your CTR2-Flex.

Appendix C: Configuring Putty

Putty is a terminal program that can be configured for a variety of needs. CTR2-Flex only supports serial
connections. This section describes how to configure the program to interface with CTR2-Flex.

NOTE: Putty does not have XModem transfer capability. If you want to export and import backup files

for CTR2-Flex’s settings, consider using Tera Term or install ExtraPutty.

Download Putty for Windows from https://www.putty.org/. It’s also available for Linux at

https://www.ssh.com/academy/ssh/putty/linux and for Mac at

https://www.ssh.com/academy/ssh/putty/mac.

You'll need to connect to CTR2-Flex using its USB serial port in order to configure it. Make sure to use a

USB data cable, not a “charge-only” supplied with many USB-C devices.

Serial Session

Select Serial then set the Serial Line to the COM Basic options for your PuTTY session

port you found in the Device Manager and set Specify the destination you wart to connect to

Speed (Baud Rate) to 115200. Serial line Speed
COom13 115200

NOTE: Since this is a USB serial port the Speed Connection type:

(baud rate) doesn’t matter. Data will be sent at (ORaw (O Telnet () Rlogin (OSSH O

USB speeds regardless of the Speed setting.
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Next, select the Terminal item and set the Implicit
LF in Every CR to on, and Local Echo, and Local Line

% PuTTY Configuration

ope Categony:
Edltlng to Force Off [ Session Cptions controlling the temminal emulation
{ ,.Logging Set various terminal options
. . . » d @ Auto wrap mode initially an
0a
You can change the window size under the Window ____Be;'b ra——
item. Set the Columns to 41 and the Rows to 20. - Features L) implct CRin every LF
- Window B Implicit LF in every CR
- Appearance [CJ Use background colour to erase screen
- Behaviour [ Enable blinking text
- Translation Answerback to “E:
[#- Selection PUTTY
- Colours
(= Connection Line discipline options
- Data Local echo:
'T'mlw O Auto () Force on O Force off
e n.et Local line editing:
EJ Slsoam O Auto () Force on O Force off
- Serial Remote-controlled printing
Printer to send ANSI printer output to:
About Help Cancel

Next, select the Keyboard menu option and note 8 PuTTY Configuration
the setting for the Backspace key. If Control-H is

. - S_ession Options controlling the effects of keys
selected you will need to press Ctrl+Backspace to - " Logging Change the sequences sent by:

. Teminal
E‘ e The Backspace key

© Control-H (O Control-? (127)

send the Del key (ASCII 127). If Control-? (127) is
selected, press the Backspace key to send the Del

key code.

Saved Sessions

Once this has been done, return to the Session menu item, enter a CTR2-Dial

. . . : r ;
name for this session and click the Save button. This allows you to [Rsz';tse“'”gs koo

. . . . . . BMax Server
easily re-open this session with just a couple of clicks. { Sav
| CTR2-Micro_Dev1 Delete
| CTR2-Mini

| Plex Server

If you right-click on the Putty icon in the Windows toolbar the last
few sessions you had open will be displayed. Just select the one you want to open it.

You can adjust the display colors on the Windows->Colours menu item. The Micro uses the Bold
attribute to highlight the hotkeys and other items. | like to set the Background color to blue and the
Bold color to yellow but you can find the colors that work for you. After you get a color combination you
like return to the Session menu and Save the session.
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Appendix D: Apple or Linux Terminal Programs

The Apple Mac and Linux have built-in terminal programs so there is no need to install a separate app.
To connect your CTR2-Flex to a terminal session use the following process.

First, list your current serial ports without CTR2-Flex plugged in.

e On the Mac open Applications/Utilities/Terminal.app. On Linux open the terminal program
supplied by your distro.

e Onthe Mac, enter Is -1 /dev/tty.usb*, on Linux, enter Is /dev/tty* This will return a list of all
known serial ports.

o Next, plug CTR2-Flex into the computer’s serial port and execute the command above again.
This is easily done by pressing the Up arrow key.

e Compare the new list with the old list. CTR2-Flex’s serial port ID will appear on just the new list.
For Mac users the serial port ID format will be /dev/tty.usbserialxxxxx where xxxxx is a unique
device ID #. Linux users will see something like /dev/ttyACMXx or /dev/ttyUSBx, where x is a
unique # for that port.

NOTE: If a new virtual serial port is not created when you plug your Micro into your PC make sure you
are using a USB-C cable that supports data. Many USB-C cables only provide power to the remote
device.

Once you know CTR2-Flex’s USB serial port ID, write it on the label on the bottom of the unit using a
fine-tipped permanent marker for future reference. Put a piece of transparent tape over the label to
seal the ink so it doesn’t rub off (it's not as permanent as you think). You can always remove the tape if
you want to change what’s written on the label.

Once you have the serial port ID, enter the following: screen {serial port ID} 9600. Include the complete
device description (i.e. /dev/ttyxxxxxxx) for the serial port ID. This will open the serial port using 9600
baud in a terminal session. The following screenshots demonstrate these steps.

1. Get the list of serial devices on your computer. We’re looking for the usb device.
r —
[ ] [ ] . lynn — -zsh — 84x24
Last login: Fri May 3@ @9:56:14 on ttyseee 1=

lynnELynns—Mac-mini ~ % ls —al /dev/tty.=*
crw-rw-rw— 1 root wheel @x%9808802 May 29 14:29 fdev/tty.Bluetooth-Incoming-Port

crw-rw-rw— 1 root wheel @&x%7880888 May 29 14:29 =
crw-rw—-rw— 1 root wheel @x5880084 May 38 18:88| /dev/tty.usbmodem3144481

lynnPLynns-Mac-mini ~ %
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2. Open the screen utility using the usbmodem31444-1 device. Your USB device will have a
different numerical #.
@ (] = lynn — -zsh — 84x24
Last login: Fri May 3@ @9:56:14 on ttys@ea 1=
lynn@Lynns—Mac-mini ~ % ls -al /dew/tty.#

crw-rw-rw— 1 root wheel @x98800882 May 29 14:29 Sdev/tty.Bluetooth-Incoming-Port
cru-rw-rw— 1 root wheel Bx9800088 May 29 14:29 Sdev/tty.debug-console

crw—-rw-rw— 1 root whee odem3144481
lynniLynns—Mac—-mini =~ %|screen fdew/tty.usbmodem3144481 9688.

3. Thisis CTR2-Flex’s terminal display. Press the indicated key to edit each field.

[ ] @® [ lynn — screen [dev/tty.usbmodem24587C5CDADC1 9600 - SCREEN — 84x24

WIFI SETTINGS MENU

1 to 9) Edit CW Macro
A} WiFi Router SSID: <Net Set>
B) Router Password: <Not Set>
c) Radio's IP Adrs: <Not Set>
D) Radio's IP Port: 4992
(Default is 4992)

Press macro # or item to change

DEMO Mode: Press Backspace or Del
to enter call & license ksyl

Appendix E: Power Requirements

The approximate current on CTR2-Flex’s USB connection is shown below for various configurations.

WiFi Mode Backlight Current
High 170 mA

on Medium 2 152 mA
Medium 1 133 mA

Low 115 mA

High 121 mA

Off Med?um 2 105 mA
Medium 1 82 mA

Low 70 mA
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Appendix F: Change Log

Changes applied to older firmware versions are documented here.

v2.00.00: July 24, 2025
e Combined CTR2-Dial firmware with CTR2-Flex firmware
o Firmwares are independent of each other
o If you migrate from CTR2-Dial v1 to CTR2-Flex v2 firmware your settings from CTR2-Dial
v1 will be applied to CTR2-Dial v2 and be available when you switch to CTR2-Dial mode
o This manual covers the CTR2-Flex firmware — see the CTR2-Dial Operation Manual for
CTR2-Dial firmware information
o Select which firmware to run in the Settings menu
o This firmware is compatible with both CTR2-Dial and CTR2-Flex hardware
o Added toggle TX control of the current slice to the CTR2-Flex Dashboard — Tx page

v1.01.00 - July 21, 2025
e Added additional information to Appendix A on preparing CTR2-Flex to flash firmware

v1.01.00 - June 28, 2025

e Added Favorite Frequency page to Keypad and Band pages

e Start on WiFi Connect when starting without WiFi AutoConnect enabled
e Bumped v1.00.09 to v1.01.00 since Favorite Freq is a feature addition

v1.00.08 - June 16, 2025
o Added formatted frequency display to Dial VFO control
e Added double-click to toggle TX enable mode on/off
e Darkened Orange and Green theme colors for better contrast

v1.00.07 - June 9, 2025
e Added Panadapter Page 2 to the Misc pages to add controls for the panadapter and waterfall —
these are also included in the virtual Dial menu
o Added Average, Gain, and Black level controls
o Added Weighted Average and Auto-Black buttons
o Added a Mute function to the Volume control

v1.00.06 - June 4, 2025
e Added a Breakin button to the Keyer menu to control breakin mode
e Caption now shows if transmit is blocked because TX is not enabled or keyer is not in breakin
mode
e Bug fix: not saving radio settings when changing slices
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v1.00.05 - June 3, 2025
e Don’t force keyer mode on radio to Straight if not in CW mode or TX is not enabled

v1.00.04 - June 1, 2025
e Fixed bug that was causing multiple controllers to follow the frequency of the slice that had Tx
enabled
e Added Tx Enable control to enable Tx in the selected slice
o Added Tx Enbl to page 4 of the Buttons menu
o Press and release Knob A to toggle Tx Enable on any screen
o The screen caption text turns red when TX is enabled

v1.00.03a - May 30, 2025
o Added Appendix D with information on using the screen command in Mac and Linux for a
terminal interface

v1.00.03 - May 23, 2025
e Fixed bug in reverse Knob A/B so press & turn Knob A changes frequency step
e Display selected slice as caption in Dashboard Home page

o Touch Dash Home page caption to open Panadapter page to change selected slice
e The parameter values now follow changes made in SmartSDR

v1.00.02 - May 18, 2025
e Fixed bug in v1.00.01 that was blocking WiFi connection

v1.00.01 -May 17, 2025
e Fixed bug in Dashboard Panadapter controls — swipe to change wasn’t working

v1.00.00 - May 15, 2025
o Fixed bugs with Swap A/B option when using it on CTR2-Dial hardware

v1.00.00aq - May 10, 2025
e Allow Knob B to change knob functions in the Knob menu.
e Added hint on getting to Programming Mode

v1.00.00a0/ap - May 3, 2025
e Added Backspace key to start registration entry and added note about DEL key mapping in Putty

e Automatically enable swipe tuning when selecting a frequency digit in the Dashboard Home
page.
e Added double-touch to turn on swipe adjustment mode on Dashboard pages to accept swipe

actions
e Added [Knobs: Swap A/B] option

v1.00.00am - May 1, 2025
e Added left/right swipe to the Dial control and the Dial, Knob, and Buttons menus to switch
between pages.

v1.00.00al - April 28, 2025
e Updated all control graphics to match new control graphics in CTR2-Dial
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All controls are now speed sensitive
Added a new keypad for direct frequency entry to the Dashboard

v1.00.00ae - March 30, 2025

Added on-screen editing for WiFi SSID, password, radio IP address and IP port

Display virtual dial when changing settings in dashboard

Moved dashboard Keyer page in front of Macro Select page

Can use encoder to select keyer macro to edit — turn to change, press to edit

Added an Info button to the Settings menu. It displays version #, call, and registration key

v.1.00.00ac - March 11, 2025

Added touch & hold to dashboard VFO to unselect it so knob can be used for other settings

v1.00.00aa - March 9, 2025

Added a new Filter page to the dashboard
Swapped bandwidth and mode button locations on Dash Home page

v1.00.00 - March 5, 2025 - Initial Alpha Release

First alpha release on CTR2 user group
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